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Statement of Compliance

Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
certifies that this instrument has been calibrated
using standards and instruments traceable to
international standards.

We guarantee that at the time of shipping your
instrument has met its published specifications.

An NIST traceable certificate may be
requested at the time of purchase, or obtained
by returning the instrument to our repair and
calibration facility, for a nominal charge.

The recommended calibration interval for this
instrument is 12 months and begins on the date of
receipt by the customer. For recalibration, please
use our calibration services. Refer to our repair
and calibration section at

Serial #:
Catalog #:
Model #: 6470-B

Please fill in the appropriate date as indicated:

Date Received:

Date Calibration Due:

D AEM ® Chauvin Arnoux®, Inc.

(_ d.b.a AEMC® Instruments
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é READ CAREFULLY BEFORE
USING FOR THE FIRST TIME

Your instrument is equipped with a NiMH battery. This technology offers several
advantages:

¢ Long battery charge life for a limited volume and weight.
* Possibility of quickly recharging your battery.

¢ Significantly reduced memory effect: you can recharge your
battery even if it is not fully discharged.

¢ Respect for the environment: no pollutant materials such as lead
or cadmium, in compliance with the applicable regulations.

After prolonged storage, the battery may be completely discharged. If so, it must
be completely recharged.

Your instrument may not function during part of this recharging operation.

Full recharging of a completely discharged battery may take several hours.

NOTE: In this case, at least 5 charge/discharge cycles will be necessary for
your battery to recover 95% of its capacity.

To make the best possible use of your battery and extend its effective service life:

¢ Only use the charger supplied with your instrument. Use of
another charger may be dangerous.

* Only charge your instrument at temperatures between 0° and 40°C.
¢ Comply with the conditions of use defined in the operating manual.
e Comply with the storage conditions specified in the operating
manual.
NiMH technology allows a limited number of charge/discharge cycles depending
significantly on:
¢ The conditions of use.
¢ The charging conditions.

Please refer to § 9 for correct replacement of the battery.

Do not dispose of the battery pack with other solid waste. Used batteries
must be entrusted to a qualified recycling company or to a company
specialized in processing hazardous materials.

3¢ B>
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CHAPTER 1

INTRODUCTION

€Y warnING

These safety warnings are provided to ensure the safety of personnel.
Please read and comply with these precautions:

» This instrument is protected from accidental voltages of not more than
50V with respect to earth in measurement CAT IV. The guaranteed level
of protection of this equipment may be compromised if used in a manner
not specified by the manufacturer.

» Safety is the responsibility of the operator.

» All metal objects or wires connected to the electrical system should be
assumed to be lethal until tested. Grounding systems are no exception.

* Never exceed the maximum rated voltage and current, and the mea-
surement category.

* Never exceed the protection limits, and always comply with the condi-
tions and place of use, indicated in the specifications.

» Do not use the instrument or its accessories if they appear damaged.

» Use accessories that have overvoltage category and service voltages
greater than or equal to those of the instrument (CAT IV 50V). Use only
accessories that comply with safety standards (IEC 61010).

» Wear the appropriate protective gear (insulating boots and gloves).

¢ Check that no terminal is connected and the switch is set to OFF before
opening the device.

* Use only the charging unit supplied with the instrument to recharge the
battery.

» Troubleshooting and metrological verification procedures must only be
performed by qualified, approved personnel, or the factory.

» NOTE: The potentials on the various rods used for an earth measurement
may be different if a nearby electrical installation is defective or certain
weather conditions prevail (thunderstorms). It is up to the operator
to decide whether to continue or postpone measurements in these
situations.

6 Ground Resistance Tester Model 6470-B

1.888.610.7664 ws www.calcert.com sales@calcert.com



1.1 International Electrical Symbols

Signifies that the instrument is protected by double or reinforced insulation.

This symbol on the instrument indicates a WARNING that the operator must
refer to the user manual for instructions before operating the instrument. In
this manual, the symbol preceding instructions indicates that if the instructions
are not followed, bodily injury, installation/sample and/or product damage may
result.

Risk of electric shock. The voltage at the parts marked with this symbol may be
dangerous.

Ground/Earth symbol

B=gH > B0

In conformity with WEEE 2002/96/EC

1.2 Definition of Measurement Categories

CAT IV: For measurements performed at the primary electrical supply (<1000V) such
as on primary overcurrent protection devices, ripple control units, or meters.

CAT llI: For measurements performed in the building installation at the distribution level
such as on hardwired equipment in fixed installation and circuit breakers.

CAT Il: For measurements performed on circuits directly connected to the electrical
distribution system. Examples are measurements on household appliances or
portable tools.

1.3 Receiving Your Shipment

Upon receiving your shipment, make sure that the contents are consistent with the
packing list. Notify your distributor of any missing items. If the equipment appears
to be damaged, file a claim immediately with the carrier and notify your distributor
at once, giving a detailed description of any damage. Save the damaged packing
container to substantiate your claim.

1.4 Ordering Information

Ground Resistance Tester Model 6470-B...........ccccceeevemmrriicinnnees Cat. #2135.01
Includes carrying bag, 110/240V power adapter with US power cord, optical USB cable,
rechargeable NiMH battery pack, and a USB stick with DataView® software, ground tester
workbook and user manual.

Ground Resistance Tester Model 6470-B Kit (150 ft) .................. Cat. #2135.02
Includes meter, two carrying bags, two 150 ft color-coded leads on spools (red/blue), one 30
ft lead (green), two 5 ft color-coded leads (red/blue), 110/240V power adapter with US power
cord, optical USB cable, two T-shaped auxiliary ground electrodes, set of five spaded lugs,
one 100 ft tape measure, rechargeable NiMH battery pack, and a USB stick with DataView®
software, ground tester workbook and user manual.

Ground Resistance Tester Model 6470-B 7
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Ground Resistance Tester Model 6470-B Kit (300 ft) .................. Cat. #2135.03
Includes meter, two carrying bags, two 300 ft color-coded leads on spools (red/blue), two 100
ft color-coded leads (hand-tied, green/black), two 5 ft color-coded leads (red/blue), 110/240V
power adapter with US power cord, optical USB cable, four T-shaped auxiliary ground
electrodes, set of five spaded lugs, one 100 ft tape measure, rechargeable NiMH battery
pack, and a USB stick with DataView® software, ground tester workbook and user manual.

Ground Resistance Tester Model 6470-B Kit (500 ft) ................. Cat. #2135.04
Includes meter, two carrying bags, two 500 ft color-coded leads on spools (red/blue), two
100 ft color-coded leads (hand-tied, green/black), one 30 ft lead (green), two 5 ft color-
coded leads (red/blue), 110/240V power adapter with US power cord, optical USB cable,
four T-shaped auxiliary ground electrodes, set of five spaded lugs, one 100 ft tape measure,
rechargeable NiMH battery pack, and a USB stick with DataView® software, ground tester
workbook and user manual.

1.4.1 Kits, Accessories and Replacement Parts

Test Kit for 3-Pole (3-Point) Testing (150 ft) ..................ccoeeeee. Cat. #2135.35
Includes one carrying bag, two 150 ft color-coded leads on spools (red/blue), one 30 ft lead
(green), two 5 ft color-coded leads (red/blue), two T-shaped auxiliary ground electrodes, set
of five spaded lugs and one 100 ft tape measure.

Test Kit for 4-Pole (4-Point) Testing (300 ft) .............cccccociiinnnenn. Cat. #2135.36
Includes one carrying bag, two 300 ft color-coded leads on spools (red/blue), two 100 ft color-
coded leads (hand-tied, green/black), two 5 ft color-coded leads (red/blue), four T-shaped
auxiliary ground electrodes, set of five spaded lugs and one 100 ft tape measure.

Test Kit for 4-Pole (4-Point) Testing (500 ft)...................ccccveeee. Cat. #2135.37
Includes one carrying bag, two 500 ft color-coded leads on spools (red/blue), two 100 ft
color-coded leads (hand-tied, green/black), one 30 ft lead (green), two 5 ft color-coded leads
(red/blue), four T-shaped auxiliary ground electrodes, set of five spaded lugs and one 100 ft
tape measure.

Test Kit for 3-Pole (3-Point) Testing

(Supplemental for 4-Pole (4-Point) TEStING) ......uuvurerriiiiiiiiiiieeeeiei e Cat. #2135.38
Includes one carrying bag, two 100 ft color-coded leads (hand-tied, green/black), one 30 ft
lead (green), two T-shaped auxiliary ground electrodes, set of five spaded lugs and one 100
ft tape measure.

Extra Large Classic TOOI Bag ........cccceeiiiiiiiiie i Cat. #2133.73
Tape Measure (100 ft) .....cveiiiiiiii e Cat. #2130.60
Ground Tester DVD/Workbook Set..........cccocoeiiiiiiiiiiiiiciccee Cat. #2130.64
Set of Two, 14.5" T-shaped Auxiliary Ground Electrodes................. Cat. #2135.39
Replacement - Carrying Bag for Meter...........ccccooviiiiiiiiiiiiciie Cat. #2135.40
Optical USB Cable.........cooiiiiiiiiiiie et Cat. #2135.41
Inverter — 12VDc to 120VAc 200 Watt for vehicle use...................... Cat. #2135.43
Replacement - Fuse, set of 5, 0.63A 250V 5x10 1.5kA.........cccecueene Cat. #2135.81
Rechargeable NiMH 9.6V Battery Pack ..........ccccceviiieiiiiiiieccineen, Cat. #2960.21
Replacement - Power Adapter 110/240V & Power Cord 115V US...Cat. #5000.13
Power Cord 115V US ... e Cat. #5000.14
8 Ground Resistance Tester Model 6470-B
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CHAPTER 2

PRODUCT FEATURES

2.1 Description

The Digital Ground Resistance Tester Model 6470-B is a portable measurement
instrument designed to measure Ground Resistance, Soil Resistivity (two methods
— Wenner and Schlumberger), Bonding Resistance (DC Resistance 2-Wire and
4-Wire Kelvin sensing) and Earth Coupling resistance. This direct reading tester
measures from 0.01 to 99.99kQ and is auto-ranging, automatically seeking out the
optimum measurement range and test current.

Easy-to-use — simply connect the leads, select the test mode, press Start and read
the results. Up to 512 test results can be stored in internal memory for later recall
to the display or downloaded to a PC via DataView® software.

The large LCD is easy-to-read and indicates ground electrode resistance, test
voltage, current and frequency as well as individual electrode resistance, battery
status and more.

The Model 6470-B is CAT IV rated to 50V and is over voltage protected to more
than 250VAc against accidental connection to live circuits. The voltage is also dis-
played on screen. In the event of a system fault, the Model 6470-B can withstand
250VAc.

Additional features of the Model 6470-B include a heavy-duty field case sealed
against dust and water when closed (the test button is also sealed against the
elements); manual and automatic test frequency selection from 40 to 513Hz; user
selectable 3-Pole (3-Point) Fall of Potential or 4-Pole (4-Point) Soil Resistivity test
methods and user selectable 2-Wire or 4-Wire Bond Resistance test method.

The Model 6470-B is powered by 9.6V, 3.5 Ah NiMH rechargeable batteries. An
external recharger powered from 120/230V 50/60Hz is included and provides for
testing while recharging. The Model 6470-B can also be vehicle powered from an
optional 12V battery adapter.

The Ground Resistance Tester Model 6470-B is rugged, easy-to-use and ideal for
maintenance crews performing numerous tests. It exceeds mechanical and safety
specifications for shock, vibration and drop tests per IEC standards. The adjust-
able test frequency provides for rejection of high levels of interference, allowing it
to be used under difficult conditions such as high stray currents that normally affect
accuracy.

Ground Resistance Tester Model 6470-B 9
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2.2 Key Features

* 2- and 4-Wire Bond Resistance/Continuity measurement (DC Resistance) with
automatic polarity reversal

» 3-Pole (3-Point) Fall-of-Potential measurement with manual or automatic
frequency selection

e 4-Pole (4-Point) Fall-of-Potential measurement for very low resistance
measurements with manual and automatic frequency selection and automatic
lead compensation.

* 4-Pole (4-Point) Soil Resistivity measurement with automatic calculation of
Rho (p) and user selection of the Wenner or Schlumberger test method

+ 3-Pole (3-Point) Earth Coupling measurement

* Manual and automatic frequency scan from 40 to 513Hz for optimum test ac-
curacy in electrically noisy environments

+ Selectable test voltage of 16 or 32V up to 250mA of test current

+ Auto-off power management

» Automatic recognition of all electrode connections and their resistance value
« Stores up to 512 complete test results in internal memory

» Optically isolated USB communication

* Remote set up and operation of all measurements using DataView® software
supplied

* Automatic report generation

+ Rechargeable NiMH batteries from wall charger or vehicle power

* Rugged dustproof and rainproof field case — IP54 rated in closed position
* Grounding standards IEC 61557 parts 4 and 5 compliant

« Includes DataView® software for data storage, real-time display, analysis, re-
port generation and system configuration

10 Ground Resistance Tester Model 6470-B
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2.3 Control Features
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Figure 2-1

Item

Description

-

Backlit LCD Display (see §2.4)

Battery charging connector

Input terminal H (Z) - auxiliary electrode

Input terminal S (Y) - auxiliary electrode

Input terminal ES (Xv) - auxiliary electrode

Input terminal E (X) - grounding electrode under test

Six program/function buttons (see §2.5)

Optical interface connector for connection to a computer

O INIOO|aA|A~W|N

Range selection switch

—
o

Start/Stop button
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2.4 Display

The Model 6470-B’s display is a custom 256 segment multi-line backlit LCD.

External voltages will be displayed only on the small displays (A2 and A3)
without the view of the main display (A1). This helps to rapidly recognize that
these are measurements of external voltages.

Backlight: The backlight turns ON automatically when entering a function and
turns OFF after the function is complete. Press the DISPLAY button to turn it back

on.

(4]

In the Set-up mode (Instrument Configuration § 4.) pressing the DISPLAY
button also selects the next configurable parameter.
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D l.L’.L‘.U KQft

DISTANCEFREQUENCY

S0 00 00 Dy-He—
888 = 0000

MEMMR CONFIG MANUALAUTO SWEEP EZE]

€] @
l SMOOTH R
REMOTE
[ COM |

-
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J

Figure 2-2

Top main display

Middle small display

Bottom small display

Warning buzzer is activated

Communication port active

Indicates the battery charge condition; the segments represent the energy

Indicates that the secondary function of a button will be used

External voltage present - this symbol is activated when the instrument

measures voltages above 60Vp
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Vol

x \ Indicates that the measurement is running in State 2 or instrument is
v i working
MANUAL Indicates MANUAL mode - the user has to stop the measurement, other-

wise the measurement keeps on running

Indicates AUTO mode - measurement stops immediately after all results
AUTO are available. In AUTO mode, the measurement frequency is automatically
adjusted to the best available disturbance voltage rejection.

Symbol not used in Model 6470-B

Indicates the 2-Wire DC resistance; calculates the offset of the cable
resistance into the result (5Q max for offset value)

Symbol not used in Model 6470-B

Symbol not used in Model 6470-B

Symbol not used in Model 6470-B

Symbolizes the soil resistivity value (Rho): W or S indicates respectively
that Wenner or Schlumberger method is used for the measurement
(changed by the Hz/oPTIONS button)

® |8|c(gB|=
=

Indicates the alarm is activated. An audible alarm will sound if the value

ALARM measured is above the limit defined in the SET-UP mode.

Indicates the instrument is controlled remotely by the RS-232/USB inter-
REMOTE face. In this mode, all of the buttons and the rotary switch are inactive,
except switching to the OFF position.

MEM Indicates that there is recorded data in memory

MR Memory recall - displayed as long as this state is active

m If blinking, indicates the measurement had a disturbance at the moment
the measurement was started.

If blinking, indicates the value is ready to be overwritten with a new value
DISTANCE or that a new value will be entered instead of “- - -”. If more than one

value has to be entered, the CHANGE A W button moves to the next one.

Indicates that the blinking value of AUTO/MANUAL mode, frequency, volt-
age or DC current direction can be changed.

SMOOTH Optional with a push on the 2nd button - sets a digital filter active
SWEEP Symbol not used in Model 6470-B

FREQUENCY | Indicates the test frequency

OBJ:TEST Memory address

CONFIG

Ground Resistance Tester Model 6470-B 13
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2.5 Button Functions

Starts a measurement and compensates for lead resistance (§ 5.2.1).

A short push (<2s) enables a faster measurement because there is no
measurement of the auxiliary rod resistances.

START/STOP | A long push (>2s) - until the second beep occurs - enables the measure-
ment of all auxiliary rod resistances.

Measurement stops automatically (AUTO) or is stopped by pressing this
button again (MVANUAL).

2 Selects the second function highlighted in yellow under the buttons.

Increases or decreases the value of the flashing parameter displayed or
# selects the next parameter. Press the button for a longer time to increase
the change of value speed at a faster rate.

> Selects the parameter to be modified or moves the cursor to the right.

MEM: Stores measurements to memory (§ 7)
MEM/MR MR: Retrieves measurements from memory.

DISPLAY/ DISPLAY: Displays all parameters of a measurement.
SMOOTH SMOOTH: Smooths the display of measurement providing a more
stable result.

Hz/OPTIONS/ Hz/OPTIONS: Enables configuration of measurement functions.
DISTANCE DISTANCE: Available for soil resistivity and V potential measurements. It
allows the setting of values of distances used for Rho (p) calculation.

14 Ground Resistance Tester Model 6470-B
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CHAPTER 3

SPECIFICATIONS

3.1 Reference Conditions

Influencing Parameters Reference Values
Temperature 68°F = 5.5°F (20°C = 3°C)
Relative Humidity 45 t0 55% RH

Power Supply 9to11.2V

Frequency Range of Input Signal 0 to 440Hz

Capacitance Parallel to Input Resistance 0 uF

Electric Field <1V/m

Magnetic Field <40A/m

In the following sections, the intrinsic error is defined under the reference condi-
tions and the operating error under the operating conditions in accordance with
IEC 61557 (1.4 and 5).

3.2 Electrical

3.2.1 Frequency Measurements

Measuring Method: Digital with a sampling frequency of 4028Hz, low pass, FFT.
The frequency of the strongest spectral component is displayed.

Measuring Rate: Display updates approx. 3 times per s.

Measurement Range 5 to 450Hz
Resolution 1Hz
Operating error + 2Hz
Min. input voltage 10mvV

3.2.2 Voltage Measurements

Overvoltages up to 75Vrms are displayed as ">65V". Permanent overvoltages
between 70 and 75V at terminals H (Z) and E (X) can cause overheating of the
overvoltage protection varistor.

Voltages of more than 75Vrms lead to error message 31 (excessive external
voltage) or 32 (voltage measurement overrange).

If terminals H (Z) and E (X) are put into contact with the line voltage, the protection
fuse will blow.
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External Voltage Measurements

Measuring Method: Digital by sampling at 4028Hz, low pass filter, FFT.
The frequency of the strongest spectral component is displayed.

Measuring Rate: Display updates approx. 3 times per s.

Measured Range 0.00 to 9.99V 10 to 65V
Resolution 0.01v 0.1v
Intrinsic error + (2% + 1ct)

Operating error + (5% + 1ct)

Input impedance Z,, Zg ¢ (Zg.c5) 1.2MQ

Operating frequency

DC and 15 to 440Hz

3.2.3 DC Resistance Measurements

Measuring Method: Voltage/Current measurement (Standard EN 61557 part 4)

Nominal Output Voltage: 16VDcC (if resistance < 22Q the output voltage is

reduced to 10VDC)

Max Output Current: > 200mADcC for resistances < 20Q

Max Overload (permanent): 50Vrms (protection up to 250V is guaranteed)
Max Inductive Load: 2 H

Max Interfering Voltage: 60Vpeak > 10Hz

Time for Auto Range Selecting: approx 5 s

Measuring Time: 8 s with automatic polarity inversion

Measuring Rate: 3 per s in manual mode

Lead Compensation: Possible from 0 to 5Q

Alarm Setting: “>” or “<” from 1 to 999Q (max 3 digits)

2-Pole mQ2 measurement

Measurement 0.12 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.99Q 99.9Q 9990) 9.99kQ 99.9kQ
Resolution 0.01Q 01Q 1Q 10Q 100Q

Intrinsic error + (2% + 2cts)

Operating error + (5% + 3cts)

16
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4-Pole mQ2 measurement

Measurement 0.020 to 10.00 to 100.0 to 1.000 to 10.00 to
Range 9.9990 99.990 999.90 9.999kQ2 99.99kQ
Resolution 0.001Q 0.01Q 0.1Q 1Q 10Q
Intrinsic error + (2% + 2cts)

Operating error + (5% + 5cts)

3.2.4 AC Earth/Ground Resistance Measurements
Measuring Method: Voltage/Current measurement (EN 61557 part 5)

Open Circuit Voltage: 16 or 32Vrms square wave (if current > 240mA the output
voltage is reduced to 10Vrms)

Test Frequency: Selectable from 41 to 513Hz (see table in § 6.2)
Short Circuit Current: > 200mAAC

Noise Suppression: > 80 dB for frequencies 20% or more above or below the
test frequency

Max. Overload: 250Vrms
Max. Value for R, & Rg: 100kQ

Measuring Time: Short push on START: approx. 7 s for first value of R; at
128Hz, then 3 measurements per s.

Long push on START: approx. 15 s for first value of R at
128Hz, then 3 measurements per s.

The following error indications refer to reference conditions with a test voltage of
32V, test frequency of 128Hz, R, and Rq = 1kQ, no external voltage.

The operating error of AC resistance measurements can be less than that speci-
fied for voltage or current because frequency characteristics of the voltage channel
are matched to those of the current channel.

Measurement of auxiliary electrodes R, R, R, R,
Measurement 0.14to 10.0 to 100 to 1.00 to 10.0 to
Range 9.99Q 99.9Q 9990 9.99kQ 99.9kQ
Resolution 0.1Q 01Q 10 10Q 100Q
Operating error + (10% + 2cts)

The START button must be pressed for more than 2 s. For frequencies between
41 and 256Hz, the resistance of the auxiliary earth electrodes is measured at the
test frequency set. At higher frequencies the resistance is measured at 256Hz.
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3-Pole earth resistance measurement R,

Measurement 0.09 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990) 99.90 9990 9.99kQ) 99.9kQ
Resolution 0.01Q 01Q 1Q 10Q 100Q2
Intrinsic error + (2% + 1ct)

Operating conditions: R <3 xR, U, =32V

Operating error for R,
Values for R, R; and R, Frequency (Hz)
(R, +RJ)/R. R, > 0Q, Rs < 3kQ 4110 513 + (3% + 2cts)
<3000 R, > 3k, Rs < 30kQ 4110513 + (10% + 2cts)
(R, +R)/R
H< 5300 E R, > 30k, Rs < 100kQ 4110128 +(10% + 3cts)

Note: For a test voltage U, of 16V, halve the value for R,..

outT

4-Pole earth resistance measurement R_

Measurement 0.011 to 10.00 to 100.0 to 1.000 to 10.00 to
Range 99990 99.990 999.90) 9.999kQ 99.99kQ2
Resolution 0.001Q 0.01Q 01Q 1Q 10Q
Intrinsic error + (2% + 1ct)
Operating conditions: R_<3 xR ,U__= 32V
pera £ o Operating error for R,
Values for R , R, and R Frequency (Hz)
R, +Ry)/R. R, > 0Q, Rs < 3kQ 4110513 + (3% + 2cts)
< 3000 R, > 3kQ, Rs < 30kQ2 4110513 + (10% + 2cts)
(R,+Ry) /R, (0o
<5000 R, > 30k, Rs < 100k 4110128 + (10% + 3cts)

Note: With a test voltage U, of 16V, halve the value of R ,.

ouTt

3.2.5 Soil Resistivity Measurement p

Measuring Method: Voltage/Current measurement (EN 61557 part 5)
Open Circuit Voltage: 16 or 32Vrms square wave

Test Frequency: Selectable from 41 to 128Hz (see table in § 6.2)

Short Circuit Current: > 200mAAc

Noise Suppression: > 80 dB for frequencies 20% or more above or below the
test frequency

Max. Overload: 250Vrms
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Max.Value for R, R, R, R.: 100kQ

Calculation Formula, Wenner: p,, = 2r d

R

S-ES

Calculation Formula, Schlumberger: p, = (1 (d2 - (A/2)%) / A) R ¢

Maximum Value of P: 999kQm (display in kQft is not possible)

Measuring Time:

128 Hz, then 3 measurements per s.

Short push on START: approx. 8 s for first value of R, at

Long push on START: approx. 20 s for first value of Ry ¢ at
128 Hz, then 3 measurements per s.

Measurement 0.00 to 10.0 to 100 to 1.00 to 10.0 to
Range 9.990) 99.90 9990 9.99kQ 99.9kQ
Resolution 0.01Q 01Q 1Q 10Q 100Q2
Intrinsic error + (2% + 1ct)

The intrinsic error specified refers to reference conditions with a test voltage of

32V, test frequency of 128Hz, R, R

p-H> " "p-8’

R esand R ¢ = 1kQ, no external voltage.

Operating conditions : R, .. <3 xR, and: Operating error for R,
H.Rtl:;Rj E: ogo igozoo + (7% + 2cts)
Relec:j:c/vﬁz_i 5S0 ifo), 000 * (15% + 3cts)
Relec:i%/mﬁ:.i 1S0 i;£02,000 + (20% + 1ct)
R, is the resistance of the earth rods Roe Rpes Rper Ry assumed to be identi-
cal.

Note: With a test voltage U

ouTt

Measurement of Auxiliary Electrodes R

R, R

of 16V, halve the value of R .

R

P-H? "Yp-s? "Np-ES? "VP-E
Measurement 0.14to 10.0 to 100 to 1.00 to 10.0 to
Range 9.99Q 99.9Q 9990) 9.99kQ 99.9kQ
Resolution 0.1Q 01Q 10Q 10Q 100Q
Operating error + (10% + 2cts)

The START button must be pressed for more than 2s. For frequencies between 41
and 128Hz, the resistance of the auxiliary earth electrodes is measured at the test

frequency set. At higher frequencies the resistance is measured at 128Hz.

Ground Resistance Tester Model 6470-B

W www.calcert.com

19

sales@calcert.com



3.3 Data Storage
Memory Capacity: 512 test results (64kB)

Communication: Optically isolated USB

3.4 Power

Power Source: Rechargeable 9.6V, 3.5Ah NiMH Battery Pack
At the middle and bottom of the display you will see one of the following messages:

bAtt CHrG Fast charging is active (normal state)

bAtt LOW Battery voltage is too low for a fast charge - charging at a lower current

bAtt Battery voltage is too high for a fast charge - charging at a lower current

bAtt HOt Battery is too warm for a fast charge (>40°C) - charging at a lower current

bAtt COLd Battery is too cold for a fast charge (<0°C) - charging at a lower current
bAtt FULL Battery is full - switch to trickle charging

Power Supply: 110/220, 50/60Hz external charger with 18Vbc, 1.9A output or
12VDc vehicle power

m In this case the low-potential of the vehicle’s 12V outlet is at the potential of
terminals E (X) and ES (Xv) of the ground tester. For safety reasons, do not
connect or use the unit if there is a possibility that voltages at E (X) or ES (Xv)
could exceed 32V.

Fuse: 0.63A, 250V, 5x20mm, 1.5kA

Battery Life:
Function Power consumed Typical number of measurements
Device off <5mwW —
Voltage Measurement 1.5W 4500
mQ @ 49W 1500
3-Pole, 4-Pole © 49W 1500
p® 49W 1500

1
2
3
4

: Measurements in automatic mode at 25-s intervals
:WithR=1Q
:With RH + RE = 100Q2

(
(
(
(4): With RH + RS-ES = 100Q

= 2 2
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3.5 Mechanical

Dimensions: 10.7 x 9.76 x 5.12" (272 x 248 x 130mm)
Weight: 7 Ibs (3.2kg) approx

Case Material: ULVO Polypropylene

Terminals: 4mm recessed banana jacks

Case Protection: EN 60529 - IP53 (cover closed)
Drop Test: Per EN 61010

Vibration Test: Per EN 61557-1

3.6 Environmental

Operating Temperature: 32° to 113°F (0° to 45°C); 0 to 90% RH
Specified Operating Temperature™: 0° to 95°F (0° to 35°C); 0 to 75% RH
Storage Temperature: -40° to 158°F (-40° to 70°C); 0 to 90% RH
Altitude: < 3000m

(1): This range corresponds to the one defined by standard EN 61557, for which an operating error including the
quantities of influence is defined. When the device is used outside this range, 1.5%/10°C and 1.5% between
75 and 90% RH must be added to the operating error.

3.7 Safety

Electromagnetic Compatibility
This instrument satisfies the EMC and LVD directives required for the CE marking
and product standard IEC 61326-1 (Ed. 97) + A1 (Ed. 98).

* Immunity in industrial environment

» Emissions in residential environment.

Electrical safety according to EN 61010
Measurement according to EN 61557
CAT IV, 50V

Pollution Degree 2

*Speci ications are subject to change without notice
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CHAPTER 4

OPERATION

m For detailed information regarding ground resistance testing, see the
Understanding Ground Resistance Testing Workbook USB drive that was
included with the instrument.

4.1 General Operating Instructions

The Model 6470-B has two operating modes:
* Automatic mode for routine applications.

* Manual (Expert) mode in which the user can change the parameters of the
measurement functions.

m Fully charge the battery before the first use (see § 9.4)

4.1.1 Automatic Mode
» Set the switch to the desired function.
* Make the connections appropriate to the function.

¢ Press the START/STOP button. The instrument takes the measurement
and stops automatically.

* Read the measurement result on the display and the relevant parameters
using the DISPLAY button.

» To save the information in memory, use the MEM button (see § 7.1).

4.1.2 Manual (Expert) Mode
» Set the switch to the desired function.
» Make the connections appropriate to the function.
» Select MANUAL mode.
* Choose various measurement parameters using the Hz/OPTIONS button.

* Press the START/STOP button. The measurement frequency or the direc-
tion of the current (resistance measurement) can be changed during the
measurement. To view the impact upon the measurement and the param-
eters relevant to the measurement use the DISPLAY button.
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*  When the measurement results are acceptable, stop the measurement by
pressing the START/STOP button.

» View the result on the display and toggle through the relevant parameters
using the DISPLAY button.

» To record the information into memory, use the MEM button (see § 7).

4.2 Instrument Configuration (SET-UP mode)
To configure the Model 6470-B parameters, turn the rotary switch to SET-UP:

» All the segments on the display are activated for 1 second and then the
“PUSH button” message appears on the display.

» Various parameters are accessible by pressing the corresponding button.

* The number or symbol which can be modified flashes. These are changed
using the SELECT button [»] and CHANGE buttons [A V].

* To exit SET-UP, turn the rotary switch to another position.

» All of the parameters that are modified are permanently saved until a new
instrument configuration is performed.

number of locations)

Parameter to be modified Button Possible values Default values
Distance unit DISPLAY (1%t press) m (meter) or ft (feet) | m
Alarm (for mQ and 2-wire | DISPLAY (2™ press) ON/OFF OFF
measurements only) direction (< or >) >

value (1 to 999Q) 2Q0
Buzzer DISPLAY (3" press) ON/ OFF ON
Modbus address DISPLAY (4" press) 110 247 1
Date Hz/OPTIONS (1%t press) | yyyy.mm.dd* Current date*
Time Hz/OPTIONS (2™ press) | hh : mm* Current time*
Baud Hz/OPTIONS (3" press) | 9.6k / 19.2k / 38.4k | 9.6 k bits
Default configuration Hz/OPTIONS (4™ press)| yes/ no yes
Memory used MEM (1%t press) 000 to 512 (total 000 on 512

*International format date and time only

Ground Resistance Tester Model 6470-B
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CHAPTER 5

AUTOMATIC MODE

VOLTAGE CHECK: The tester first checks for possible interference. If there
is an external voltage of more than 42V, the warning triangle Z\ will be
displayed. If measurements are being performed in AUTO mode and a
disturbance frequency is detected, the tester will automatically look for a
frequency that is different from the default 128Hz.

5.1 Switching the Test Voltage
Available in all functions except mQ.

If necessary, the test voltages can be switched to either 16 or 32V as follows:

* Press the Hz/OPTIONS button, then press it again to make the output volt-
age (Uout) blink.

* Use the » button to switch to 16 or 32V, then press Hz/OPTIONS again.

This setting is retained when the unit is turned off.

5.2 Resistance Measurement mQ (2-Wire)

WARNING: Before performing the resistance test, verify that the sample
under test is not energized.

1. Set the switch to .

2. Connect the resistance to terminals H (Z) and E (X).

H
@
O S
v
R| «—
O ES
(Xv)
O E
)
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3. The 6470-B makes a measurement with a positive current (R+), then reverses
the direction of the current and makes another measurement with negative (R-).

o) [} e
@ . -\ oF
R - o o = " R -' '- '-‘
. g
” ‘R/:LARM . R= (R+) + (R-) R/‘\"LARM g X)
- R 2 [ e B Y
R- R- g X
E 9 Q Ao
@ AUTO @ e
START/STOP

4. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

R+, R-, +U, ., +l, ., -U, ., -, U-Act (U, . and its frequency) and R if there
is compensation for the measurement leads.

5.2.1 Lead Compensation Measurement

Lead compensation subtracts the resistance of the test leads from the measured
result.

» Short the two measurement leads connected to H (Z) and E (X) terminals.

¢ Press the 2nd button, then the START/STOP button to start the measure-
ment.

* This value will be deducted from all resistance values measured thereafter
until the rotary switch is turned to another function.

H o)) [}
O @ @ +
O S R - - - - "
Q
I o RALARM "
7eooc
O (EXVS) Gé AR
o¢ 0 O
2nd START/STOP ® Auto

appears on the display after the compensation value has been measured.

m If the compensation resistance is > 5Q, or if the leads are not shorted when the
measurement is started, the value of compensation will be canceled.
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5.2.2 Alarm Function

This function is active only for 2-Pole resistance measurements. By default, the
visual alarm (ALARM symbol flashes) and the audible alarm (buzzer sounds for a
few seconds) are triggered when R < 2Q.

This threshold can be changed using the SET-UP function:

~
@ PN
V4 ALI\RM<\ -
_
Lo
X2

O

DISPLAY
Turn the alarm Access the Choose a low (<) or

ON or OFF type of alarm high (>) alarm

A > A
Set the value of the alarm Complete the adjustment

between 1 and 999Q of the alarm setting
E ﬁ E X3
» and A DISPLAY
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5.3 Resistance Measurement mQ (4-Wire)

This measurement is used to improve the resolution (10x better than the 2-Wire
measurement) for low resistance values.

To perform a 4-Wire measurement:

Press HzZ/OPTIONS — Press Hz/OPTIONS once again
(AUTO will blink) (H and E will blink)

O=>
O=>

Hz/oPTIONS Hz/oPTIONS
Press » Confirm choice by pressing
(H, S, ES and E will all blink) =™ Hz/OPTIONS again

U=
O=>

Hz/0PTIONS

WARNING: Before performing the resistance test, verify that the sample
under test is not energized.

1. Set the switch to .

2. Connect the resistance to all 4 terminals.

O

@ .
—
o &

| O (E)

X
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3. Start the measurement by pressing the START/STOP button.

o) [T}
® e (330 ¢
@ ' L = .‘ L’ Q
o " 1208,
START/STOP @ ) " :::";o:-" " )

4. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:
R+, R-,+U, ., +l ., -U

HE  HE

ne e U-Act (U, . and its frequency)

5.4 Earth/Ground Measurement (3-Pole)

This function is used to measure an earth (ground) resistance with 2 auxiliary
electrodes.

There are several measurement methods, the full and simplified (62% method) will
be discussed in this section.

5.4.1 62% Method
1. Set the switch to .

2. Place electrodes H (Z) and S (Y) to form a straight line with the earth electrode
under test.
The distance between electrode S (Y) and the earth electrode is 62% of
the distance between electrode H (Z) and the earth electrode; the distance
between the electrodes H (Z) and E (X) should be 8 to 10 times the depth of
the rod you are testing.

O ("Z‘l

O &

oF

(V) :

I | distance d - 62% d O
< distance A - 8 to 10 times rod depth >

-

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
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taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).

Connect the cables to terminals H (Z) and S (Y) (red and blue respectively); dis-
connect the earth strap from the rod under test, then connect terminal E (green) to
the rod or electrode system to be tested.

3. Press the 2nd button, then the DISTANCE button. The "hundredths" will blink.

on)) [}

®R
H £ - o o o
1
O]
H
:! R: - e o e m
Id

@ D Ei \I?IISTANCE
" Smim = -

d =" .
2nd DISTANCE @ AuTO

4. To modify the hundredths (of meters or feet), press the A button until the
desired digit is displayed (0-9).

5. To select and modify the tens, press the » button and then the A button until
the desired digit is displayed (0-9).

6. To select and modify the units and tenths of a unit, press the » button and
then the A button until the desired digits are displayed (0.0-9.9).

7. To terminate the programming of distance, press the 2nd button and then the
DISTANCE button.

It is also necessary to program distance A. This is done in the same way as for
distance d.

8. Start the measurement by pressing the START/STOP button.

on) [} o) [}
@ -— -, > - @ EARTH -—, . e

e |

‘E‘ @ -¥r'e '@ =) @ £ - a¥sa’ Q

i" (O u I

i A= OLOLLLS 5-£ RO i}
@ i g T8 @ ! (0T

" d= DO H-E [ A |
START/STOP @ e DISPLAY @ Ao

9. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:
R, U U-Act (U,, . and its frequency, U . and its frequency).

S-E’ IH-E‘
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To measure the resistances of auxiliary electrodes H (Z) and S (Y), or if the resis-
tance of the electrodes is too high (see § 10.1), start the measurement with a long
press of the START/STOP button.

R, Rg will be displayed.

o) [T}
@ EARTH - . -,
R Ll
@ £ L .’l .' Q
R [N (]
> 2s H LD
- Y
5 L kQ
START/STOP @ e

NOTE: Repeat the process at 52% and at 72% for the S electrode.

5.4.2 Full Method

A more thorough measurement can be obtained by taking measurement by mov-
ing the S (Y) auxiliary electrode every 10% between H (Z) and E (X) and plotting
the results. A distinct plateau should result as shown below.

R90
R80
R30 R40 R50 Re0 R70
R20

R10

0 10 20 30 40 50 60 70 80 90 100

% H-E
Take the average of the 3 or 4 readings on the R40 + R50 + R60 + R70
. ) R=
plateau to obtain the earth electrode resistance. 4
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5.4.3 Recommendations for a Reliable Measurement

Moving the Auxiliary Electrodes

Move electrode S (Y) towards electrode H (Z) by a distance equal to 10% of d and
make another measurement. Then move electrode S (Y) again by a distance equal
to 10% of d, but towards the earth electrode.

H
@
- ! L oF
|

H (2) ''s(Y) | o o5
T T — :
[ [ [ | 52%d %
—> —

. 62% d R

P 72% d 4

p A d A -

The three measurement results should be the same to within a few percent. If this
is the case, the measurement is valid.

If not, electrode S (Y) is in the zone of influence of the earth electrode. It will be
necessary to increase distance d for the H (Z) auxiliary electrode and repeat the
measurements.

Positioning of the Auxiliary Electrodes

To make sure that your earth measurements are not distorted by interference, we
recommend repeating the measurement with the auxiliary electrodes placed at a
different distance and in another direction (for example, rotated 90° from the first

alignment).
H(Z)® A
s(y)e |&
H (2) S (Y)
° ° EX)e ¥
< d >
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If you find the same values, your measurement is reliable. If the measured values
are substantially different, it is likely that they were influenced by earth currents or
a groundwater source. It may be useful to drive the electrodes deeper and/or wet
the ground near them to reduce their contact resistance with the soil.

Avoid routing the connecting cables of the earth electrodes near or parallel to other
cables (transmission or supply), metallic conductors, rails, or fences: high test fre-
quencies may cause cross-talk and affect the measurements.

5.5 Earth/Ground Measurement (4-Pole)

This function is suited to the measurement of very low earth resistances. It
provides better resolution (10x better than 3P measurement) and there is no need
to compensate for the resistance of the measurement leads.

1. Set the switch to .
2. Place electrodes H (Z) and S (Y) at least 30m apart.

O
Ch l o8
4 Pole (G 4o —O
ﬂ+ H@) smjr A m—
] ] I

>30m >30m -

—>

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.). Connect the cables to terminals
H (Z) and S (Y); disconnect the earth strap from the rod under test, then connect
terminals E (X) and ES (Xv) to the earth electrode to be tested.

3. Start the measurement by pressing the START/STOP button.

o) ML}

®

R A1
o L (0,
® Us—es '.:lEl'.l'r""

I g x}
P v =
@ AUTO
START/STOP
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4. To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:
Re, Uge |y e U-Act (U, - and its frequency, U, . and its frequency).

To measure the resistances of auxiliary electrodes H (Z) and S (Y), or if the resis-
tance of the electrodes is too large (see § 10.1), start the measurement with a long
press of the START/STOP button.

R, R, U, ¢ will be displayed.

o)) [T}
@ -, w, ww

i
@ F Vem 2’ Q

R [ (]
> 2s @ H L

S -y
® wo

START/STOP

We recommend repeating the measurement with the auxiliary electrodes placed at
a different distance and in another direction (see § 5.4.3).
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5.6 Soil Resistivity Measurements (P Position)

To measure the resistivity of the soil, two measurement methods are possible:
Wenner and Schlumberger

The difference between the two methods lies in the positioning of the electrodes.
By default, the device selects the Wenner method. The Schlumberger method,
which allows you to move only two measurement electrodes rather than three, is
better suited for measuring soil resistivity at multiple depths.

The soil resistivity measurement with different distances d, and therefore in dif-
ferent layers (in depth) of the soil, can be used to establish resistivity profiles of
the soil in question, which can be useful for geological analysis, the exploration
of deposits, hydrological studies, etc., and to determine the location of an earth
electrode.

1.888.610.7664

5.6.1 Advantages and Disadvantages of Wenner and Schlumberger
SCHLUMBERGER WENNER
Advantage Disadvantage Advantage Disadvantage

Need to move the two
potential electrodes ES
(Xv) and S (Y) only for
most readings. This can
significantly decrease the
time required to acquire
a sounding

Al four electrodes, the two
current E (X) and H (2) and
the two potential ES (Xv)
and S (Y) must be moved
equally to acquire each
reading.

Because the potential
electrode spacing is
small compared to

the current electrode
soakings, higher meter
sensitivity is required.

Potential electrode
spacing increases

as current electrode
spacing increases. Less
sensitive meters may
be used.

Because the potential
electrodes remain in
fixed locations, the ef-
fects of the near surface
lateral variations in
resistivity are reduced.

Because all electrodes

are moved for each
reading, this method can
be more susceptible to
near-surface, lateral, and
variations in resistivity.
These near surface lateral
variations could potentially
be misinterpreted in terms
of depth variations in
resistivity.

In general, interpretations
based on DC soundings
will be limited to simple,
horizontal; layered
structures

In general, interpretations
based on DC soundings
will be limited to simple,
horizontal; layered
structures.

Source: DC Resistivity - T. Boyd
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5.6.2 Changing the Measurement Method

1. Set the switch to @

2. Press the Hz/opTiONS button. "AUTO" will blink.

o) ML}
® P
H
®
4 300
& e 30D
H (30
! N
@ CONFIG  — AUTO =
Hz/oPTIONS “s N

3. Press the Hz/opTIONS button again. "W" will blink.
4. Press the » button to change to the Schlumberger method.
5. To confirm and exit, press the Hz/oPTIONS button twice.
o) i} o)
@ Pr: ® Py
© o
é Uout J‘EU v éf_ out BEE v X2
! (0 e i (0
( ) : [ glx] ( ) U [gix] (: )
Hz/oPTIONS @ CONFIG AUTO ’ @ CONFIG AUTO Hz/oPTIONS

To switch back to the Wenner method, simply repeat this procedure.

The last measurement method selected (Wenner or Schlumberger) is stored in
memory when the device is switched off.

5.6.3 Programming the Distance for Electrode Placement

The distance can be programmed before or after the measurement. If it is not
programmed, only the value of Ry ¢ will be displayed, since the value of p remains
indeterminate.

1. Set the switch to @

2. Press the 2nd button, then the DISTANCE button. The "hundredths" will blink.
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3. To modify the hundredths (of meters or feet), press the A button until the
desired digit is displayed (0-9).

4. To select and modify the tens, press the » button and then the A button until
the desired digit is displayed (0-9).

5. To select and modify the units and tenths of a unit, press the » button and
then the A button until the desired digits are displayed (0.0-9.9).

6. To terminate the programming of distance, press the 2nd button and then the
DISTANCE button.

In the case of the Schlumberger method, it is also necessary to program distance
A. This is done in the same way as for distance d.

5.6.4 Wenner Method

1. Set the switch to @

2. Place the 4 earth electrodes on a straight line, at a distance d from one an-
other and at a depth p <1/20 d. Distance d must be between 2 and 30m.

3. Connect the cables to the electrodes, then to terminals H (Z), S (Y), ES (Xv),
and E (X) in sequence.

4. Program the distance into the instrument as described in § 5.6.3.

SN
O3
O 5
—O §

In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).
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5. Start the measurement by pressing the START/STOP button.

L

START/STOP

on)) M}
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P
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To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

Pw Reger di U U-Act (U, . and its frequency, U, . and its frequency).

S-ES’ lH-E’ S-ES

To measure the resistances of the auxiliary electrodes H (Z), S (Y), ES (Xv) and E
(X), or if the resistance of the electrodes is too high (see § 10.1), start the measure-
ment by a long press of the START/STOP button.

R.:and R, then R, . and R, ¢ will be displayed.
o) i} o)
@ w @ w - -
L SN
(;) ‘ ’ ’ka (;) ( ( kQm
L e 42 L e M2
> 2g & P-E A K ® P-E5 p ke
SO LW G O |4 % i3
® -H Au-r.o- kQ @ ALI'I:O- kQ
START/STOP DISPLAY

5.6.5 Schlumberger Method

1. Set the switch to @

2. Place electrodes S (Y) and ES (Xv) at a distance A apart, then place elec-
trodes H (Z) and E (X) in the same straight line, at a distance d measured from
the midpoint of distance A. Distance d must be between 2 and 30m.

it

Drive the electrodes to a depth p of not more than 1/20 of d.

>

Connect the cables to the electrodes, then to terminals H (Z), S (Y), ES (Xv),
and E (X).

5. Program the distance into the instrument as described in § 5.6.3.
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In order to avoid electromagnetic interference, it is best to unwind the full length of
each cable from the reel, to keep the cables as far apart as possible on the ground,
taking care not to form loops, and to avoid placing the cables near or parallel to
metallic conductors (cables, rails, fences, etc.).

6. Start the measurement by pressing the START/STOP button.
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To display the measurement parameters, press DISPLAY several times.
The device displays the following parameters:

Per Reper d, U U-Act (U, . and its frequency, U, . and its frequency).

S-ES’ | H-E’ S-ES

To measure the resistances of the auxiliary electrodes H (Z), S (Y), ES (Xv),
and E (X), or if the resistance of the electrodes is too high (see § 10.1), start the
measurement by a long press of the START/STOP button.

R..and R, then R, . and R, ¢ will be displayed.
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CHAPTER 6

MANUAL MODE

All of the measurement functions described in § 5 (AUTO mode) can be performed
in MANUAL mode if necessary.

To access MANUAL mode:

* Press the Hz/OPTIONS button once. The Hz/OPTIONS symbol appears
and the AUTO indicator blinks.

« Use the » button to switch from AUTO to MANUAL.

*  When the tester is in MANUAL mode you can press Hz/OPTIONS repeat-
edly to see various parameters that can be set, depending on the measure-
ment function selected.

When a measurement is periormed by a short or long press on the START/STOP
button (the circular arrows \i ) on the display will rotate), the measurement can be
stopped by a second press of this button.

Whenever a new measurement function is selected, the device automatically
changes back to AUTO mode.

6.1 Switching the Test Voltage
Available in all functions except mQ.
If necessary, the test voltages can be switched to either 16 or 32V as follows:

* Press the Hz/OPTIONS button, then press it again to make the output volt-
age (Uout) blink.

» Use the » button to switch to 16 or 32V, then press Hz/OPTIONS again.

This setting is retained when the unit is turned off.
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6.2 Measurement Frequency Selection

If there are signals with a frequency that could interfere with the chosen test fre-
quency, the NOISE symbol will appear.

While in MANUAL mode, change the frequency by pressing the Hz/OPTIONS
button until the frequency flashes.

Press the » button to choose the following frequencies:
« USr, 55, 92, 110, 119, 128 Hz (128 Hz is default).
* 128, 1367, 1611, 1758 Hz for the 2-clamps function (1611 Hz is default).

To change the user frequency (USr), press the A ¥ buttons (A V raises the value,
and 2"+ AV lowers it).

Table of possible USr frequencies (48 values from 41 to 513Hz):

41 43 46 49 50 55 60 61 64 67 69 73 79 82 85 92
98 | 101 | 110 [ 119 | 122 | 128 | 134 | 137 | 146 | 1569 | 165 [ 171 | 183 | 195 | 201 | 220
238 | 244 | 256 | 269 | 275 | 293 | 317 | 330 | 342 | 366 | 391 | 403 | 439 | 476 | 488 | 513

There are two user frequencies: one for resistivity and one for earth and soil po-
tential measurements. These two values remain in memory even after the device
is switched off.

For soil resistivity measurements, the user frequency is limited to 128Hz.

6.3 Manual Settings for mQ2 Measurements

Pressing Hz/OPTIONS in MANUAL mode allows the following parameters to be
changed using the » button:

» Terminal symbols H and E blink > H S ES E blink (4-Pole measurement)
* POS on H and DC+ blinks > neg on H and DC- (reversal of polarity at terminal H)

In MANUAL mode the tester does not reverse polarity automatically during the
measurement; however, the polarity can be reversed during the measurement by
pressing the Hz/OPTIONS button.
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6.3.1 Continuity Test
The 2-wire mQ measurement gives a quick measurement result, accompanied by
an audible beep, during a continuity check.
The display is in the sensitivity range (0.5Q to 1.99kQ) and the terminal check is
limited to terminal H (Z) (a cable must be connected to it), making it possible to
start the measurement with an open circuit.
For a continuity check, the following settings are mandatory:

*  The 2-wire mQ measurement function must be selected.

* The device must be in manual mode.

* The alarm function must be active (On).

* The alarm threshold must be low (<).

* The buzzer must be activated (bEEP On).

6.4 3-Pole Earth/Ground Measurements & Coupling

6.4.1 3-Pole Earth/Ground Measurements

Pressing on Hz/OPTIONS in MANUAL mode allows the following parameters to
be changed using the » button:

* EARTH blinks - Earth Coupling Measurement
e 128 Hz blinks - Test Frequency Measurement
» Testvoltage blinks - Test Voltage Selection

6.4.2 Earth/Ground Coupling Measurements

This measurement calls for making and storing three intermediate measurements
(at the same frequency). It is available only in MANUAL mode.

Connection diagram:

Measurement #3
Earth 1 Earth 2

Measurement #2

R,

Measurement #1

R,
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Press Hz/OPTIONS and use the » button to switch from EARTH to EARTH COU-
PLING. Proceed as follows:

« If you want to eliminate the resistance of the measurement leads, you can
use lead compensation (2nd + START) before starting the actual coupling
measurement (see § 5.2.1).

* Turn the rotary switch to 3-Pole.
» Select a test frequency and a test voltage (if desired).

* The screen displays EARTH COUPLING 1. Make a 3-pole earth measure-
ment on the first earth system (measurement of R, in the connection dia-
gram on previous page).

» Stop the measurement by pressing the START/STOP button. The MEM
symbol flashes to indicate that this result must be recorded in memory.
Press the MEM button twice. To save to another location, refer to §7.

* The screen now displays EARTH COUPLING 2. Make a 3-pole earth mea-
surement on the second earth system (measurement of R,). For this second
measurement, leave the H (Z) and S (Y) electrodes in the same positions as
for the first measurement.

» Store this result in the same memory location as before by pressing the
MEM button twice.

* The screen now displays the message EARTH COUPLING 3. Disconnect
terminal S (Y) and make a 2-wire resistance measurement with terminal H
(Z) connected to earth 1 and terminal E (X) to earth 2.

* Record this result by pressing the MEM button twice.
e EARTH COUPLING 4 and the results of the measurements are displayed.
The calculation is based on the following formulas:
R.=(R,+R,—R,,)/2
C,=R/J/R,andC,=RJ/R, R,=R,-R,
Rb = Rz - Rc
» To display all of the measurement parameters, press the MR button.

» To scroll through all of the measurements, use the » and A buttons.
i] then i] i] i] E] x4
» | 4 A

2nd MR
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Press DISPLAY several times to display the following parameters:

EARTH COUPLING 1 R., U, . and frequency, U

1 Uour s her U-In (U . and frequency)

R, and R if long press of START/STOP

EARTH COUPLING 2 R,, U,,; and frequency, U, ., I, ., U-In (U . and frequency)
R, and R if long press of START/STOP

EARTH COUPLING 3 R, U, and frequency, I, ., U-In (U, . and frequency).

EARTH COUPLING 4 R;,C,C, R, R,U  and its frequency.

6.5 4-Pole Earth/Ground Measurements
Pressing the Hz/OPTIONS button allows the following parameters to be changed
using the » button:

*  128Hz blinks - Change the test frequency

» Test voltage blinks - Switch between 16 and 32V

6.6 Soil Resistivity Measurements
Pressing the Hz/OPTIONS button allows the following parameters to be changed
using the » button:

*  Pw blinks (Wenner method) - Switch to Ps (Schlumberger method)

*  128Hz blinks - Change the test frequency

» Test voltage blinks -> Switch between 16 and 32V

6.7 Smoothing

In the manual mode, you can activate or deactivate the smoothing of the measure-
ment results by pressing the 2nd + DISPLAY (SMOOTH) buttons. This smooth-
ing displays an exponential mean value, a significant help with highly fluctuating
values.
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CHAPTER 7

MEMORY FUNCTION

The instrument has a total of 512 memory locations. Each of these locations is
defined by an object number (OBJ) from 01 to 99 and by a TEST number from 01
to 99.

For 3- and 4-pole earth measurements, the sweep mode (SWEEP) can record
several measurement results at the same memory location, with the frequency as
third addressing criterion.

During soil potential or resistivity measurements (WWenner or Schlumberger meth-
ods), several measurement results are recorded at the same memory location,
with the distance between electrodes as the third addressing criterion.

For earth coupling measurements (EARTH COUPLING 1, 2, 3, 4), the four mea-
surements provide the third addressing criterion for the same memory location.

None of the other measurements has an additional addressing criterion, so each
occupies only one memory address.

Since each measurement is dated, you must set the date and time of the device
before any storage in memory (see § 4.2).

7.1 Saving Measurements into Memory
Measurement results can be saved by performing the following:

* Press the MEM button. The tester will automatically suggest the next free
memory location (F r £ £ message).

* Press the MEM button a second time to save to the OBJ/TEST location.
« If you decide not to save your results, press DISPLAY to exit MEM mode.
» To change the OBJ and TEST location, use the » and A V¥ buttons.

NOTE: If a memory location is already occupied, the message ot L will be dis-
played. Pressing the MEM button will overwrite the measurement record.

For soil resistivity and potential measurements, if several measurements are made
with different distances (d), you can store them under the same OBJ:TEST num-
ber, with the distance being the third criterion.

It will be possible to overwrite values already stored with new ones having the
same distance d, or even to add new results having other values for the distance d
provided that all of the other measurement parameters are identical.
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7.2 Recalling Measurements from Memory

To recall saved measurements, perform the following:
+ Select a measurement function, then press the 2" and MR buttons.
* Usethe » and A V buttons to choose the OBJ and TEST numbers.
» Press the DISPLAY button to display the time (tiME) and date (dAtE).
* Press DISPLAY again to display the measurement and its parameters.
* Press the MR button again to exit the recall mode.

The SET-UP function lets you read all memory addresses one after the other
independently of which measurement function is chosen.

Any measurement stored in the tester can be retrieved individually using Data-
View® software (see § 8).

7.3 Erasing Measurements from Memory

There are two ways to erase measurements - complete and selective.

7.3.1 Erasing All Measurements
» Set the switch to SET-UP.

+ Push once on the MEM button to display the number of free and available
records.

* Push a second time on the MEM button.

* The display will show “dEL ALL". Change the blinking NO to YES with the A
button, then perform a long press (>2s) on the MEM button.

[L] WARNING: This will delete ALL saved records.

» To exit without erasing, perform a short press on the MEM button.

7.3.2 Erasing Selective Measurements
» Set the switch to SET-UP.
+  Press the 2" button.

* Press the MR button. The Object and Test numbers of the last stored test ap-
pear, with the Object number blinking.

« If you need to change the Object number, press the A button until the desired
number is displayed. Then press the B button; the Test number now blinks.
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* Press the A button until the desired test is displayed.

* Press the MEM button to display the dEL screen. By default, the blinking word
NO appears on the screen, indicating the test is not to be deleted. To delete
the test, press the A button to change the blinking NO to YES, then press and
hold down (>2s) the MEM button. To exit without erasing, perform a short press
on the MEM button.

Note that if the test stored in this Object/Test number is a sweep test (which con-
sists of multiple measurements taken at different frequencies) this procedure only
deletes a single measurement. The remaining sweep measurements will still be
stored in this Object/Test. You must delete all individual measurements to com-
pletely remove a sweep test.

When a test is deleted, its Object/Test number is removed from memory. When you
subsequently view stored tests, this number will be skipped. This Object/Test num-
ber combination remains unavailable for storing tests until you completely erase
memory, as instructed in Section 7.3.1.
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CHAPTER 8

DATAVIEW® SOFTWARE

8.1 Installing DataView®

DO NOT CONNECT THE INSTRUMENT TO THE PC BEFORE INSTALLING THE
SOFTWARE AND DRIVERS.

NOTE: When installing, the user must have Administrative access rights
during the installation. The users access rights can be changed after the
installation is complete. DataView® must be reinstalled for each user in a
multi-user system.

1. Insert the DataView thumb drive into an available USB port on your com-
puter. If Autorun is enabled, an AutoPlay window appears on your screen.
Click “Open folder to view files” to display the DataView folder. If Autorun is not
enabled or allowed, use Windows Explorer to locate and open the USB drive
labeled “DataView.”

2. When the DataView folder is open, find the file Setup.exe located in the root
directory of the USB drive, and double-click it to run the installation program.

3. The DataView setup screen appears.

In the upper left corner of the screen, choose the language vesion of the
Setup interface. (All Setup screens and diaogs will immediately appear in the
selected language.)

In the lower left corner are the available installation options. In addition to the
DataView software, you can select “Adobe Reader.” This links to the Adobe
web site where you can download the latest version of Reader. This program
is required to view DataView .pdf documents. The option Firmware Upgrades
links to the website where you can check for new firmware updates for the
instrument. Finally, User Manuals displays a list of .pdf files contained in the
USB drive that accompanies DataView. (DataView also comes with a Help
system that is installed with the program files.)

To install DataView, select DataView in the Options list and click Install.
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4. Select the language version of DataView you want to install (English, French,
or Spanish) then click Next. (By default, the language selected in step 3 is
highlighted.).

5. You are now prompted to select the software you want to install. Each AEMC
product family has its own specially designed Control Panel. If you are per-
forming a Complete install, by default all available Control Panels are selected
(a check mark next to the Control Panel indicates it is selected). Control Panels
take up disk space on the computer; so unless you have other types of AEMC
instruments, we recommend that you select Ground Tester and deselect the
rest. You should also check the option DataView Core, which is a requirement
if you plan to create DataView reports.

After you finish selecting and deselecting Control Panels and/or DataView
Core, click Next.

6. The Setup program now informs you that it is ready to install DataView. If you
want to review any of your previous selections, click the Previous button to
return to earlier screens. Otherwise, click Install to begin installation.

7. The InstallShield program installs the selected software. If an earlier version
of the software is already installed on your computer, for each selected pro-
gram the InstallShield program will:

(a) Ask you to confirm the installation of the program. Click Next.
(b) Display a status bar indicating the progress of the installation.

(c) Inform you when the program is installed. Click Finish to install the next
selected program.

If the software is not installed (or if the installed software is the same version
as the selected software), the software is installed without requesting confir-
mation.

When all programs are installed, a message appears informing you of this.
Click Finish to return to the Setup screen.

8. You can now select additional Setup options to install (see step 3 above).
When finished, click Exit.

9. The DataView folder now appears on your computer desktop, within which is
the Ground Tester # icon and the icon(s) for any other Control Panel(s) you
have installed.
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8.2 Connecting the Model 6470-B to your Computer

The Model 6470-B is supplied with an optically isolated USB interface cable
required for connecting the instrument to the computer. This cable (Cat. #2135.41)
is equipped with a USB type A on one end, and an optical connector on the other
end.

To connect the Model 6470-B to your computer:

1. Connect the optical connector end of the cable to the serial port on the
front panel of the Model 6470-B (see Figure 2-1, Item #4).

2. Connect the USB type A end of the cable, to an available USB port on
your computer.

8.3 Establishing Communication to the Instrument

* Double-click the Ground Tester Icon in the DataView folder that was created
during software installation, located on the desktop.

* The Connection dialog box will appear. Make sure that the communication port
matches the port that the serial cable is plugged into.

Connection @

Commurications Port | CA USE to Dptical Gerisl Cable vI ok,
Communication R ate [ 38400 v ]
Bus Address 1

Figure 8-1
*  Once the proper communication parameters have been specified, click OK.

If the instrument is turned ON at the time the Control Panel is opened, a commu-
nication link will happen automatically.

If the instrument is turned OFF at the time the Control Panel is opened, establish a
communication link by going to Instrument > Connect in the main menu.

m The connection status can be seen in the lower right-hand corner of the
Control Panel and in the Instrument window under status.
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8.4 The Ground Tester Gontrol Panel

After communication to the instrument is established (see § 8.3), the Ground
Tester Control Panel will appear.The Control Panel consists of the following:

* A shortcut toolbar.
» Atoolbar with the mode selection and start/stop buttons.

* The instrument's status window (on the left-hand side):
- Recorded data from the instrument
- Real-time data
- Connection status
- The communications port and speed of the connection
- The model number, serial number, and firmware version
- Date and time from the clock
- Battery status

» Aconfiguration window that shows all of the parameters available for modifi-
cation. This window defaults to the instrument mode that is selected.

» Real-time Measurement window that shows the measurement of each test
performed in real-time (available only after a test has been performed).

If the indicated items are not shown on the screen, select Restore Default Layout
from the Window menu.

8.5 Configuring the Instrument

First, establish a connection to open the Control Panel (see § 8.4). Located on the
right-hand side of the Control Panel is the Configuration window.

Choose a mode to configure: | g | |HJ'=-| |HJ'=-| | P |

Common buttons and features in all 4 modes are:

* Load from File: Retrieves stored configurations to be used in programming
the instrument.

» Save to File: Saves the current configuration. This file will reside on the
computer’s disk drive. Saving different configuration setups can be useful
for future functions and tests.

* Set Instrument Clock: Updates the clock to the PC clock.
e Buzzer: When selected, buzzer is ON.
e Alarm: When selected, alarm is ON.

* Drop-down Indicators: Indicates the configuration available for each mea-
surement range.
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m To set the Terminal Label markings (e.g. E, ES, S, H or X, Sv, Y, Z), Numeric
format, Measurement units and Rho units, go to Tools > Options.

8.5.1 DC Continuity Test

When DC Continuity is selected from the tool bar, you can:
» Select a 2- or 4-Wire test.
» Select a test current (positive, negative or Auto +).
« Enter and activate an alarm from 1 to 999Q (2-Wire only), if desired.

For very low resistance measurement, a lead compensation value (see § 5.2.1)
may be entered using the Change button.

Input noise status at the input of the meter is always displayed.

8.5.2 3-Pole Ground Resistance Test

When 3-Pole Ground Resistance is selected from the tool bar, you can select:
*  With or without Auxiliary Rod Resistance.
» Test voltage of 16 or 32VAc.
« Distance "d" from terminal X to terminal Y.
» Distance "a" from terminal X to terminal Z.

» Auto frequency - selects the optimum frequency (from 41 to 513Hz), usually
128Hz, or select manually from the drop-down frequency list.

Selecting a sweep frequency test from the drop-down list will enable the sweep
table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.
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8.5.3 4-Pole Ground Resistance

When 4-Pole Test Resistivity is selected from the tool bar, you can select:
»  With or without Auxiliary Rod Resistance.
» Test voltage 16 or 32VAc.

» Auto frequency - selects the optimum frequency (from 41 to 513Hz), usually
128Hz, or select manually from the drop-down frequency list.

Selecting a sweep frequency test from the drop-down list will enable the sweep
table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.

8.5.4 4-Pole Soil Resistivity @

When 4-Pole Test Resistivity is selected from the tool bar, you can select:
«  With or without Auxiliary Rod Resistance.
» Test voltage 16 or 32VAc.

» Auto frequency - selects the optimum frequency (from 41 to 128Hz), usually
128Hz, or select manually from the drop-down frequency list.

» Test Method - Wenner or Schlumberger.

» Distances - the distance “d” (for Wenner test method) or “d” and “a” (for Sch-
lumberger test method), between the test electrodes, needs to be entered
for resistivity calculation to read out directly in Rho.

Selecting a sweep frequency test from the drop-down list will bring you to the
sweep table selection.

The Input Noise option allows the viewing of noise for Z or Y inputs.
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8.6 Tools Menu

8.6.1 Tools > Options
» Set number display as scientific (1000 as "1E+3") or letters (1000 as "1k").
« Set Label Terminals to be "X", "Xv", "Y", "Z", or "E", "ES", "S", H".
* Set Measurement units to meter or feet.
» Set Rho units to Ohm-meter or Ohm-centimeter.

8.6.2 Tools > Colors

Sets colors for measurement channels.

8.6.3 Tools > Recover Data

Every time the directory of recorded data is displayed by the Ground Tester Control
Panel, a backup copy of all the data is saved to a file. Use this option to recover
previous data.

8.7 Starting a Test

Press the START button to begin a test. Some tests configurations are automatic
and end when the data is stable. Others, generally when there is a manual fre-
quency, show a STOP button, which should be pressed when the data is available
on the screen and has stable values.

8.8 Downloading Data to Database

Click the plus sign next to Recorded Data from the instrument in the Instrument
window on the left-hand side.

Select the data you want to download by clicking on the file name. Choose to per-
form one of the following:

e Print: Prints the data.
e Create DataView Report: Opens the newly created report in DataView®.

e Create Spreadsheet. Allows you to save as either an .xIs (Excel spread-
sheet file) or .csv (comma delimited file).
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8.8.1 Session Properties

After creating a DataView® report, you can open the Session Properties dialog box
by selecting Edit > Edit Session Properties.

The Session Properties dialog box allows you to specify Operator, Site and Custom
parameters that are to be saved with recorded data. These parameters are used
when generating reports.

The Operator and Site tabs allow you to maintain lists of operators and sites,
saving you time when specifying parameters for reports.

On the left of the Operator and Site tabs is the list of previously defined Operators
and Sites. On the right of the Operator and Site tabs is the individual parameters
that will be saved in an associated database. Only a single set of operator and site
fields are saved in the recording database.

The Custom tab allows you to set up user defined parameters. Click the New
button to create a user defined parameter. Double-click on the name (or click the
Edit button) to assign a name and value. A checkbox appears to the left of the
value. ltems that are checked will be added to an associated database and used
in displaying a report. Only a single set of Custom parameters can be maintained
(unlike the Operator and Site lists).

m You can also set defaults for session properties within the Ground Tester
Control Panel by selecting File > Edit Session Properties.

8.9 Exporting the Report to a PDF File

» Select the data by clicking on the file name under Recorded Data from the in-
strument in the Instrument window on the left-hand side of the Control Panel.

e Click the Print button.

* In the Print dialog box that appears, select PDF-XChange 3.0 from the drop-
down menu, then click OK.

* When the PDF is complete, the Save As dialog box will appear.

* Choose a location to save the file and click Save.
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CHAPTER 9

MAINTENANCE

Replacement batteries and fuses are available directly online.
Check our Storefront at www.aemc.com/store for availability.

9.1 Maintenance

Please make sure that you have read and fully understand the WARNING
section on page 3.

» To avoid electrical shock, do not attempt to perform any servicing unless
you are qualified to do so.

» To avoid electrical shock and/or damage to the instrument, do not get water
or other foreign agents into the case.

¢ Turn the instrument OFF and disconnect the unit from all circuits before
opening the case.

» Use specified spare parts only.

9.2 C(Cleaning

ﬁ Disconnect the instrument from any source of electricity.

Use a soft cloth lightly moistened with soapy water. Wipe with a moist cloth and
then dry with a dry cloth. Never use alcohol, solvents or hydrocarbons.

9.3 Fuse Replacement

* Fuse for terminal H (2):

If this fuse is defective, the unit will no longer produce an output voltage, making it
impossible to perform resistance measurements.

To test this fuse, turn the switch to the mQ position (2-Wire), connect measurement
leads to terminals H (Z) and E (X) and start a measurement. If the unit refuses to
operate and the symbol for terminal H (Z) blinks, the fuse must be replaced.
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Only use the type of fuse shown on label inside the instrument’s cover:
0.63A 250V 5x20mm 1.5kA (Cat. #2135.81)

Procedure for replacing fuses:

1. Disconnect the unit completely, turn the rotary switch to OFF, and close
the lid.

2. Loosen the four permanent screws at the bottom of the unit, but do not
remove them.

3. Open the lid and carefully turn the housing upside-down, making sure
the front panel does not fall out. Then carefully pull the front panel and
the unit all the way out of the housing.

4. The fuse for terminal H (Z) is accessible at the back of the unit (in the
corner near the terminal for the battery charger).

5.  Wipe off any dirt on the seal and housing rim.

6. Put the unit back into the housing and screw it into place.

9.4 Recharging the Battery

m To make the best use of the battery and prolong its service life, observe the
following rules.

* Use only the battery charger supplied with the unit; other chargers may be
hazardous!

» Recharge the battery only at temperatures between 32° and 104°F (0° and
+40°C).

» Observe the conditions of use and storage defined in the specifications.

Even an NiMH battery can be recharged only a limited number of times. This num-
ber, and thus the service life of the battery, is highly dependent on the following
factors:

» the operating conditions
» the recharging conditions

As the earth tester might go some time without use and the battery has a natural
tendency to run down, you should check the battery level at regular intervals. To do
this, turn on the unit and check the battery level indicator at the top of the
display. If there is only one bar in the symbol or if there are no bars at all, the bat-
tery should be recharged.
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If the unit is not used for a long time, the battery might run down all the way. In
this case, recharging can take several hours. In addition, the unit might not work
properly at the start of recharging.

The capacity and lifetime of the battery may also be diminished. After about five
charging/discharging cycles the battery will recover its initial capacity.

To recharge the battery, plug the charging unit into the connector at the upper left
(connector @ in Fig. 2-1) and connect the charging unit to a 100 to 240VAC power
source (suitable for Europe and the U.S.). The frame of the battery symbol will
blink during charging. Charging goes faster when the tester is turned off. The bat-
tery voltage is shown on the large display next to Ubatt.

At the middle and bottom of the display you will see one of the following messages:

bAtt CHrG Fast charging is active (normal state)

bAtt LOW Battery voltage is too low for a fast charge - charging at a lower current

bAtt Battery voltage is too high for a fast charge - charging at a lower current

bAtt HOt Battery is too warm for a fast charge (>40°C) - charging at a lower current

bAtt COLd Battery is too cold for a fast charge (<0°C) - charging at a lower current
bAtt FULL Battery is full - switch to trickle charging

The 6470-B tester can also be recharged from a 12Vbc car outlet with a special
charging unit.

m In this case the low-potential of the vehicle’s 12V outlet is at the potential of
terminals E (X) and ES (Xv) of the ground tester. For safety reasons, do not
connect or use the unit if there is a possibility that voltages at E (X) or ES (Xv)
could exceed 32V.

9.5 Replacing the Battery

The battery in this unit is a special product with customized safety features and
protective devices. It should be replaced only by the same model. If a different
model is used, there is a danger of fire or explosion, leading to possible damage
or injury.

m NOTE: Only replace the battery with an identical model:
NiMH Custom Pack 9.6V / 3.5 Ah (Cat. #2960.21)

Procedure for replacing the battery:

1. Disconnect the unit completely, turn the rotary switch to OFF, and close
the lid.
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2. Loosen the four permanent screws at the bottom of the unit, but do not
remove them.

3. Open the lid and carefully turn the housing upside-down, making sure
the front panel does not fall out. Then carefully pull the front panel and
the unit all the way out of the housing.

4. Loosen the two screws on the lid of the battery case and remove the lid.

Pull the battery a short way out of the case without overstretching the
connection leads, and loosen the two screws at the bottom of the case.
Then put the battery back into the case.

6. Making sure the battery leads are not overstretched and that the battery
does not fall out, carefully lift off the back of the unit, turn it over and
place it next to the front panel with the electronic components.

7. Press the clip off the plug, and pull out the plug with the four battery
leads (in the corner, near the terminal for the optical interface). Avoid
touching the circuitry or components.

8. Remove the old battery from the case and put in a new one. Run the
leads with the plug through the largest slot in the battery case.

9. Insert the battery plug (in the corner, near the terminal for the optical
interface). The two pins should point towards the clip. Avoid touching the
circuitry or components.

10. Return the back of the unit (with the new battery in the case) to the front
panel with the components, taking care not to stretch the battery leads.
Carefully lower the back of the unit and make sure that it is aligned
correctly (the four cylindrical holes on the back must slip over the four
mounting pins on the front panel). Also make sure you do not pinch the
battery leads or other wires or components.

11. Pull the battery a short way out of the case without overstretching the
connection leads, and re-tighten the two screws at the bottom of the
case. Then put the battery back into the case.

12. Put the lid back onto the battery case and screw it shut.
13. Wipe off any dirt on the seal and housing rim.

14. Put the unit back into the housing and screw it into place.
15. Fully charge the new battery in the unit before using it.
16. Reset the time and date.

m If the instrument is not used for long periods of time (more than 6 months)
it is recommended to make several charge-discharge cycles (3 to 5 times).
Discharge cycle (15 H) can be made with the instrumentin MANUAL mode,
DC 2-Pole (2-Pole) resistance measurement and a short-circuit between H
(2) and E (X) plugs.
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CHAPTER 10

TROUBLESHOOTING

10.1 Error Reporting

10.1.1 Electrode Resistance Too High

This can happen in a 3- or 4-pole earth measurement, a resistivity measurement,
or an earth potential measurement.

This message is displayed when the measurement is triggered by a short press of
the START/STOP button and the resistances of the auxiliary electrodes are too high.

The measurement must then be started by a long press on the START/STOP but-
ton. The device then measures the values of the electrodes and compensates for
them to display the correct result.

10.1.2 Out of Range

_o<",_ or S '>'~_ The flashing > or < symbol indicates the measurement is
S “/y\~>  out of range.
If both symbols flash together, it means that the accuracy
of the value displayed is outside of the instrument

_O<"~_ and S '>': specification or is subject to large fluctuations. Activating

S ‘1> the smoothing function (SMOOTH) may correct this.
Press the 2nd button, then the SMOOTH button to activate
smoothing.

10.1.3 Misconnection

NIV NV, NV \1, This flashing indicates that a terminal
~ ” ~ - ~ - ~ - . .
- ® - o= @ - = @ o= @ - needs to be either connected or discon-
- ~ - ~ e ~ - ~ .
s s e /1Y nected. You must correct the connections

or the measurement will not proceed. The
flashing of terminal H may also indicate that
current |, . is too low. The flashing of termi-
nal S may also indicate that resistance R
is too high.
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To reduce R, you can add one or more electrodes, 2 meters apart from each
other, in the H (Z) leg of the circuit, or increase the test voltage.

To reduce R, you can add one or more electrodes, 2 meters apart from each
other, in the S (Y) leg of the circuit.

To reduce the resistance of the electrodes, you can also drive them deeper, pack
the ground around them well, or dampen them with water.

10.1.4 Out of Limits Indicators

R This flashing during a passive measurement means that the device
- &\— has detected the presence of an external voltage exceeding 42V on
ot the terminals and that the measurement is impossible.

ﬁ This flashing during an active measurement means that the operat-
ing limits have been exceeded.

If this symbol remains lit during an active measurement, it means
that the values measured are subject to large fluctuations or that
there is an incorrect connection.

m The display of an indefinite value for a passive measurement indi-

cates that measurement current I_¢ or I, or voltage Ug ¢ is too low.

The display of the NOISE symbol indicates that a stray external voltage is likely to
interfere with the measurement. You should change to manual mode and change
the measurement voltage and/or frequency in order to make a valid measurement.

After the measurement has started there are indicators of when:
* Values R,, and/or R are too high,

« Measurement current | s or g, is too low,

H-E’ 'E
* The instability of the measurement is large.
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10.1.5 Error Messages

When started up, the Model 6470-B device automatically performs a self-test. If a
fault appears during this self-test or during a measurement, the device displays a
message in the form Err XX.

There are 3 categories of errors:

e Harmless Errors 6, 7, 11

The message appears for approximately 1 second to inform
the user. Consider a repair if the error recurs.

» Errors 6 and 7 are always preceded by an automatic reset.

* During Error 11, the tester automatically resets to the fac-
tory default settings.

e Correctable Errors 5, 14, 15,18, 19, 30, 31, 32 and 33
These errors concern the current measurement function and
disappear if the function is changed. The device can therefore
be used, but a repair will be necessary if the error persists.

* Error 18 indicates that the rechargeable battery in the
tester cannot be recharged. If this error occurs during
recharging, disconnect the tester from the charger and
follow the procedure described in the “fatal” errors.

« Error 19 can be corrected by clearing the entire memory of
the unit (see section 8.3).

* Errors 31, 32 and 33 indicate excessive voltage or
excessive current during a measurement. Check the
measurement setup for faults.

e Fatal Errors 0,1, 2, 3, 8, 12, 13, 15, 16, 18 (during battery recharge)
and 21
These errors make operation of the unit impossible. Turn off
the unit and turn it on again. If the error persists, repair is
necessary.
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APPENDIX A: GLOSSARY

GLOSSARY OF TERMS

Basic Terminologies
Explanations for some of the basic terms related to earth measurements follow:

Auxiliary electrode - H (Z)
A supplementary electrode through which a measurement current flows.

Earth conductor

The conductor which connects the installation to be earthed to the earth elec-
trode.

Earth connection

A locally restricted group of electrically connected earth contacts. It also in-
cludes metal parts of installations such as pylon footings, bracings, cable
sheathing and earth conductors.

Earth electrode - E (X)
A conductor which is buried in the earth and makes electrical contact with it.

Earth potential

The potential difference measured between the earth connection and a refer-
ence earth electrode.

Earth electrode - ES (Xv)

A connection on the earth electrode or earthing system used for measuring
the potential of the earth electrode.

Earth resistance

The resistance measured between the earth connection and a reference earth
electrode (cf. selective earth resistance).

Earth
The location of an earth connection (see also reference earth).

Earthing system
The set of all installations connected to the earth.

Electrode - S (Y)
An auxiliary electrode used for measuring the potential of the reference earth.
The voltage, which is proportional to the resistance of the earth connection, is
measured between this electrode and the earth electrode.
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Reference earth
The area of earth (especially at the surface) which is outside the range of influ-
ence of the earth electrode or earthing system.

Resistivity of the earth (p)

Resistivity is defined as the resistance from wall to opposite wall of a cubic
meter of soil. It is measured in ohm-meters (Qm).

Selective earth resistance
The parallel partial resistance of an earth connection or earthing system. It
is measured by selective measurements of current in the corresponding re-
sistance branch. A selective earth resistance is always greater than the total
earth resistance (parallel connection).

Step voltage
The potential difference bridged by a person who takes a step of 1m (approx.
3 ft), with the resulting current flowing through the body from one foot to the
other (cf. touch voltage).

Supplementary electrode
An additional earth electrode (earth stake, earth rod).

Touch voltage
The potential difference which a person is able to bridge with his or her body,
the resulting current being limited by the body and the local earth resistance
(cf. step voltage).

The general term earth measurement can refer to measurements of individual
earth electrodes, earth connections or entire earthing systems, depending on the
object of interest.

Glossary

This glossary lists the terms and abbreviations used on the instrument and the

digital display.

3-Poles : measurement of earth resistance with 2 auxiliary stakes (3-
Pole method)

4-Poles : 4-Pole measurement of low earth resistance with 2 auxiliary
stakes (4-Pole method)

C, . earth coupling coefficient R, with earth R (C,=R./R,)

C, . earth coupling coefficient R, with earth R, (C,=R./R,)

d, A . distances to be programmed to calculate resistivity according
to the measuring method used

mQ : measurement of low resistance /continuity
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E . terminal E (X) - earth socket; current measurement return

terminal

EARTH . earth measurement (3 or 4 poles)

EARTH COUPLING : coupling measurement between two earth sockets

ES : ES (Xv) terminal (measurement potential socket for
calculating earth resistance)

H . H (Z2) terminal (measurement current injection terminal)

I-Act . external current circulating at present between the instrument
terminals

Le : measurement current circulating between the H and E

terminals

NOISE : indicates the presence of external interference causing
misrepresentation of the earth or resistivity measurement

R . average resistance calculated from R+ and R-

R+ . resistance measured with a positive current circulation from
terminal Hto E

R- . resistance measured with a negative current circulation from
terminal Hto E

R-Act . resistance currently calculated from values U-Act and I-Act

R, . first value measured to calculate the coupling between 2 earth

sockets (R, =R, +R.)

R, . second value measured to calculate the coupling between 2
earth sockets (R, =R +R;)

R,, - third value measured to calculate the coupling between 2
earth sockets (R,, =R, +R,)

R, . first earth value calculated (R, =R, - R.)

R, . second earth value calculated (R, =R, -R.)

R, . coupling resistance between earths R, and R, (R = (R, +R,
-R,,)/2)

R, . earth resistance connected to terminal E

R, - resistance of the stake connected to terminal H

R; s . value of the R-Act resistance (PASS for "passive"
measurement with interference current circulating in the
installation)

R, . resistance of the stake connected to terminal S

R, @ . resistance between stakes S and ES (used for resistivity
measurement)
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R, . measuring lead compensation resistance

S . S (Y) terminal (reference potential socket for calculating earth
resistance)

U-Act @ . external voltage currently present on the instrument terminals

U, . voltage measured between terminals H and E

Uour . voltage generated by the instrument between terminals H and
E (32V or 16V)

Ug. . voltage measured between terminals S and E

Ug s . voltage measured between terminals S and ES

Ug, . frequency chosen by the user

Ugeo . voltage of terminal S (compared with E) expressed as a
relative value (rEL); value without unit

Ps : ground resistivity measured according to the Schlumberger
method (expressed as Q.m)

Pw . ground resistivity measured according to the Wenner method

(expressed as QQ.m)

(1) The suffix Act becomes In (for "Input” in English) when this value is recorded by the instru-
ment and then read, to make a distinction between the current and recorded values. In both
cases, this value on the display is associated with its frequency.

(2) In this case, the resistances of the 4 rods used for measurement are indicated by R, ,, R
R R

P-s?

P-ES? | “P-E*
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Repair and Calibration

To ensure that your instrument meets factory specifications, we recommend
that it be scheduled back to our factory Service Center at one-year intervals
for recalibration, or as required by other standards or internal procedures.

For instrument repair and calibration:

You must contact our Service Center for a Customer Service Authorization
Number (CSA#). This will ensure that when your instrument arrives, it will be
tracked and processed promptly. Please write the CSA# on the outside of the
shipping container. If the instrument is returned for calibration, we need to
know if you want a standard calibration, or a calibration traceable to N.I.S.T.
(Includes calibration certificate plus recorded calibration data).

Ship To: Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive
Dover, NH 03820 USA

Phone: (800) 945-2362 (Ext. 360)
(603) 749-6434 (Ext. 360)
Fax: (603) 742-2346 or (603) 749-6309
E-mail: repair@aemc.com
(Or contact your authorized distributor)

Costs for repair, standard calibration, and calibration traceable to N.I.S.T. are
available.

NOTE: You must obtain a CSA# before returning any instrument.

Technical and Sales Assistance

If you are experiencing any technical problems, or require any assistance with
the proper operation or application of your instrument, please call, mail, fax or
e-mail our technical support team:

Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
200 Foxborough Boulevard
Foxborough, MA 02035 USA
Phone: (800) 343-1391
(508) 698-2115
Fax: (508) 698-2118
E-mail: techsupport@aemc.com
WWw.aemc.com

NOTE: Do not ship instruments to our Foxborough, MA address.
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Limited Warranty

The Model 6470-B is warranted to the owner for a period of two years from
the date of original purchase against defects in manufacture. This limited war-
ranty is given by AEMC® Instruments, not by the distributor from whom it was
purchased. This warranty is void if the unit has been tampered with, abused or
if the defect is related to service not performed by AEMC® Instruments.

Full warranty coverage and product registration is available on our
website at

Please print the online Warranty Coverage Information for your records.

What AEMC® Instruments will do:

If a malfunction occurs within the warranty period, you may return the instrument
to us for repair, provided we have your warranty registration information on file
or a proof of purchase. AEMC® Instruments will, at its option, repair or replace
the faulty material.

Warranty Repairs

What you must do to return an Instrument for Warranty Repair:

First, request a Customer Service Authorization Number (CSA#) by phone
or by fax from our Service Department (see address below), then return the
instrument along with the signed CSA Form. Please write the CSA# on the
outside of the shipping container. Return the instrument, postage or shipment
pre-paid to:

Ship To: Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments

Phone:

Fax:
E-mail:

Caution: To protect yourself against in-transit loss, we recommend you insure
your returned material.

NOTE: You must obtain a CSA# before returning any instrument.
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